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Chapter

1

Installation
Installation XE "Installation"  of Version 1
Start by downloading the installation program from the Northern Hills Software website.   
If you already have a version of Homestead Manager installed, make sure you close the program before running the installation download.   You never need to uninstall an older version first.  Homestead Manager will install on top of any current version.     You must have administrator privileges XE "Install:Administrator Privileges" 

 XE "Administrator privileges"  during installation although that is not required when you use the program.
Running the Installation program
Start the installation by clicking on the program setup file that you downloaded from the Northern Hills Software website. 
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The first panel allows you to select which language you wish to use for the installation wizard display.  The installation program will automatically try to select the correct language based on the value set in “Regional Settings” on your computer.
Press “Next” to continue.
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Select “I Accept” if you agree to the terms of the License Agreement XE "License Agreement" .   You cannot continue the install without accepting the License Agreement.

Press “Next” to continue.
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If this is a new installation a recommended location will be supplied for installation of the program.   You can however u XE "Install:Installation location on desktop computer" se the [image: image5.png]


 button to select a different location using the standard windows “Browse for Folder” dialog.  
A shortcut for Homestead Manager is always placed in the Programs menu. XE "Shortcut:Program (Desktop)" 

 XE "Install:Programs shortcut (Desktop)" 

 XE "Shortcut:Start Menu (Desktop)" 

 XE "Install:Start menu shortcut" 

 XE "Shortcut:Desktop" 

 XE "Install:Desktop shortcut"   You may also select to have a shortcut placed on your desktop or on the start menu.   Shortcuts can be defined as available for all users or just for the installation user. 
Press “Next” to continue.
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The next panel will show you where the program will be installed and gives you one last chance to change options before installation.   (Use the “Back” button to change installation options.)

Press “Install” to start the installation.
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The next panel shows the progress of the installation and displays the files that are copied to your computer.   When the installation is complete, a success or failure message will be displayed in the window.

Press “Next” to continue.
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This is the final panel that will be displayed.   Homestead Manager will automatically start unless you uncheck the “Launch Program on exit” option.

Press “Finish” to exit the wizard.
Setup

The first time you run Homestead Manager you will be prompted for initial program configuration information.
Location of Databases XE "Location of Databases"  

You will be asked to select the location for the Homestead Manager databases and other common files.  This prompt will only occur the first time you run Homestead Manager.
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Registration Code XE "Registration (unlock) code" 
You will be prompted to “register” the program.  If you are using the program in “trial” mode, you can ignore this screen by pressing “OK”.   This screen will show the number of days you have remaining for the trial.
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If you have already purchased Homestead Manager, press the “Register” button to enter your personal details and to request your unlock code.  See following section for more details.
Requesting Unlock (Registration) Code
If you have purchased Homestead Manager, the “Registration Center” is used to request your unlock (registration) code.  Only Email and Name are required, all other information is optional.  All information is considered confidential and private and will never be shared with any individual or organization outside of Northern Hills Software.   We use this information for support purposes only.
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After entering the information, press the “Request Code” button.  (Do not enter anything in the “Code” field, this information will be sent to you via Email once we verify your purchase.)
Pressing the “Request Code” button will connect you to Northern Hills Software to submit the information.
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If the program is able to successfully submit your information, you will receive the following message.
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Otherwise you will receive a message that shows how to manually submit this information from our website.
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Check for Updates XE "Check for Updates" 
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By default, you will receive a prompt at program start which allows you to check the Northern Hills Software website for updates to Homestead Manager.     You will receive this prompt every time you start the program unless you check the “Don’t show this prompt again”.    You can also manually check for a program update at any time using ‘Check for Update’ found under the ‘Tools’ menu.

You can turn automatic ‘Check for Updates’ on or off or set the number of days between checks from the ‘Options’ dialog invoked from the ‘Tools’ menu.

(This page intentionally left blank)
Chapter

2
Getting Started
New Homestead XE "New Homestead" 
The initial Homestead Manager screen is divided into different panels and will have a default size (width and height) for each panel.   The size of the screen (which is true with most Homestead Manager screens) can be adjusted to fit your needs.   Changes you make to the size or position of these screens are automatically saved.   
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The first order of business is to create a new Homestead (Database) so you can start entering data.  Select ‘New Homestead’ under the ‘File’ menu.
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Enter the name you wish to give your Homestead and Press ‘OK’.  (You can rename it later if you wish.)   It will take a few seconds to create the new homestead, then you will see the following prompt:
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The Homestead Manager ‘Wizard’ is a means to add predefined information to your database such as species and breeds.  It is recommended that you run the wizard initially to see what type of information can be added.   You can cancel out of the wizard if you do not want to add information using that method. 
New Homestead Wizard XE "Wizard:New Homestead" 
The new homestead ‘wizard’ provides a quick and easy means to add predefined information to your homestead.

Categories XE "Wizard:Categories" 
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Categories are one of the most powerful features of Homestead Manager.   Categories are used to group one or more animals and animals can be defined to more than one category.  For example, you can have a category named “Dogs” that would contain all dogs you have defined in Homestead Manager.   You could also have a category called “English Shepherds” that would contain all dogs of that breed, or perhaps a category called “Dogs that like bones”.   The possibilities are endless.  A category can be anything you wish for grouping one or more animals.   (Type of animal, location of animal, characteristics of an animal, etc.)
Use the Categories tab to select one or more ‘predefined’ values or add your own.   Categories can also be added later outside of the wizard.

Locations XE "Wizard:Locations" 
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Homestead Manager allows for ‘locations’ which are either considered “on-site” (part of the Homestead) or “off-site” (not located on the Homestead).   You can be as generic or specific as you like regarding locations.  For example, if you wish to think of the entire Homestead as a single location, you could just create an “On-site” or “My Homestead” or a “Here” location.   If you wish to be more specific, you could create locations such as “Front Pasture”, “Back 40”, “Chicken House”, “Barn”, etc.    Off-site locations can also be as specific or generic as you like.
Use the Locations tab to select one or more ‘predefined’ values or add your own.   Locations can also be added later outside of the wizard.

Lists XE "Wizard:Lists" 
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There are fields within Homestead Manager that are selected from a list instead of freeform data entry.  For example, when entering a medical event you can pick the ‘Delivery Method’ of the medication which is selected from a predefined list.  You can use this wizard to populate these lists with a set of predefined values.  (There is always a way to add items to a list from the screen where you are selecting the item.  Using the wizard is just a means to quickly add a set of values that are common.)   It is suggested you select all items on the ‘Lists’ tab as you can always add or delete items later once you determine what values work best for you.
Species XE "Wizard:Species" 
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Use this tab to add one or more species to your Homestead.  Species are used to classify the type of animal and can be as scientific or informal as you like.  Selecting a specie will also add a predefined set of breeds, events, identifiers and names applicable to that specie.   It is highly recommended that you use the species tab to add the animals that you will have on your homestead.

Press “OK” to add the selected items to your Homestead.  You can come back later and re-run the ‘Wizard’ for your Homestead and add items not selected the first time.

Setting Homestead Owners XE "Owners:Setting" 
After creating the Homestead, the next thing you may wish to do is define the owners of the homestead.   This will be important if you wish to ‘hide’ animals in the Animals list that are not members of this homestead.   Use the button found next to the database list to add one or more owners of this Homestead.
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You will be presented with the list of currently defined owners (which will be empty the first time).
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Use the ‘New’ button at the bottom left to create the first owner.   The new contact screen allows for a ‘general’ or specific contact name such as ‘Doe’s Homestead’ or ‘John Doe’.  If you use a ‘general’ name, there are fields defined to add two specific contacts for that location.  After adding one or more ‘owners’ for the homestead, you must also ‘check’ those items in the list to set them as the owner.
Main Screen XE "Main Screen" 
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The main screen is made up of 5 panels.

1. Category list.   Selecting a category in this list will cause only animals defined to that category to be displayed in panel 2.

2. Animal list.  This list shows the animals that are associated with the category selected in panel 1. 

3. Animal Photo. If you have any photos attached to the animal selected in panel 2, the ‘primary’ photo will be displayed

4. Event list.  This list will show events, characteristics, breeding, identifier and alternate name information defined for the animal.   More details about the selected item in this list will be shown in panel 5.

5. Details list.  Shows the details of the event, characteristic, breeding, etc. selected in panel 4.
Adding XE "Adding:Animal"  the First Animal

Click the right mouse button in the ‘Animal’ list and select ‘Add’ from the pop-up menu or use “Add”, “Animal” from the main menu to add an animal to the Homestead.  You will be presented with the following screen.
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Name, Specie and at least one category are required, all other fields are optional.

You can select a specie from the drop down list or use the New or List button to add or select the specie of your choice.   After you pick specie, the breeds specific to that specie will appear in the breed list.  Additionally, if you pick a specie that has gestation or heat defined in the specie record and you select ‘Female’ as the gender, Gestation and Heat fields will be displayed beneath the dam/sire fields.
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The values shown will default to values set either in the specie or breed record, but you can override the values to be specific to the animal.  (Do not modify these fields if you wish to use the defaults set in specie or breed)
Gender will default to Unknown.  A gender must be selected before this animal can be used in a breeding record.

The ‘Active’ check box will by default be selected.  If this animal is no longer associated with the homestead in any manner, deselect this checkbox.  (Animal could have been sold or have died, for example)  You can select options under ‘View’ on the main menu so that only active animals are shown in the animal list.

The ‘Born’ and ‘Died’ buttons allow for a quick addition of a birth or death event for the animal.   The date associated with the event will be display to the right of the button after saving the event.

The Note button [image: image28.png]


 will be grey if no note is associated with this animal.  Once a note is defined the button will be in color (red).
Next to the note button is the ‘Owner’ button to be used to select who owns the animal.  This is important if you wish to show or hide animals in the main animal list based on whether they are owned by this homestead or not.  Next to the owner button is the ‘Breeder’ button.  This is used to supply who bred the animal.

User Reference is a value that can contain any information that identifies or describes this animal, the use of this field is totally up to the preference of the user.

The Dam and Sire for this animal can be selected from this screen.  If this animal is added as part of a breeding record, the Dam and Sire will be defined from the breeding information and will not be modifiable from this screen.

If you select a specie that has gestation or heat information associated with it and you select a gender of ‘Female’, the Gestation and Heat fields will be displayed.   This allows you to set heat or gestation information unique to a particular animal.  Generally you should use the value specified in the Specie or Breed record, but if you have an animal that typically deviates from those values, this option allows you to set it specific to that animal.   (Values set per animal override values set at the breed level with overrides values set at the specie level)

The Name and Identifier lists allow you to add alternate names or add identifiers (such as tattoo, microchip, organization id’s, etc.) to the animal.   There is an option from the main ‘View’ menu that allows alternate names and identifiers to also be shown in the main animal list.

Once the animal record has been added, the main screen will show that animal in the list as well as the information about the animal in the detail lists shown underneath the animal list.   You can now add events, characteristic records and breeding records to the animal.
(This page intentionally left blank)
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3
How to 

This chapter goes into detail on how to accomplish various tasks in Homestead Manager.

Create XE "Homestead:Creating"  a new homestead
You can have as many homesteads defined to Homestead Manager as you like.   To create a new Homestead, select “New Homestead” from the “File” menu.

[image: image29.png]Name of

This is the name of your Homestead, Ranch or Farm. You can
change the name later by using 'File’, 'Rename Homestead"
from the menu.

You can create multiple Homesteads within Homestead
Manager.





Then enter a name to be used for the Homestead.   The last Homestead opened in Homestead Manager will be the default Homestead opened the next time you start the program.   To switch to a different Homestead, pick the one you want from the drop down list under the menu.

Delete a homestead XE "Homestead:Deleting" 
To delete a Homestead, first select that Homestead from the drop down list found under the menu.   Then use ‘Delete Homestead” from the ‘File’ menu.   You will be prompted to confirm the deletion.  Deleting a Homestead will not delete the backups for that Homestead.   
Rename a homestead XE "Homestead:Renaming" 
To rename a Homestead, first select that Homestead from the drop down list found under the menu.   Then use ‘Rename Homestead” from the ‘File’ menu.   A dialog will be shown that will allow you to enter the new name for the homestead as well as rename all the backups associated with that homestead. 

Switch XE "Homestead:Switching between multiple"  between Homesteads
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If you have multiple Homesteads defined in Homestead Manager they will all show up in the drop down list on the main screen.   Simply pick the Homestead from the list that you wish to use.   The last Homestead that you use will be the default homestead opened when you start Homestead Manager the next time.

Resize a list column XE "Lists:Column Width" 
Most lists in Homestead Manager will allow you to resize the columns in the list.   Move your mouse over the vertical bar that separates the column header for the column you wish to resize, then hold down the left mouse button and move the mouse to resize the column.   Double clicking on the vertical bar between columns will automatically resize the column to the width of the header text.

Change the column order of lists XE "Lists:Column Position" 
Most lists in Homestead Manager will allow you to change the order of the columns.  Using the mouse, single left click on the column header you wish to move and hold down the mouse.  Then drag the column to the location in the list where you wish to place it.

Save List Column Widths and Position

Most of the lists in Homestead Manager allow you to resize the columns and set the order of the columns as you choose.   If you want to automatically save the changes you make to column size or position, turn on this default from the “Options” screen.  (‘File’, ‘Options’)

Tip: Change the lists to how you like them, then turn off this option so that you don’t accidentally save changes you make to the list later.

Tip: You can reset the column width and order for all lists by first turning on this option, then turning it off.  The prompt will ask if you want to reset to the default.

Change the display language (Regional Setting) XE "Language:Changing" 
Select ‘Language’ from the file menu to display a list of Languages/Regional Settings that you can pick for Homestead Manager.  If you select “Default”, it will use the value as defined in Control Panel for your system.   Only those languages that have translations for Homestead Manager will be displayed, use the “Show All” to display all regional setting values available.   The Regional Settings are used by the program for such things as sorting and date display.
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Homestead Manager does not yet have any translations, if you wish to work on a translation in your native language please contact Northern Hills Software for more details.

Enter your registration (unlock) code

After purchasing Homestead Manager, on the ‘Registration Center’ screen (‘Tools’, ‘Registration Center’), you can enter your personal information to submit to Northern Hills Software in order to get a registration/unlock code.   After you receive the email with the code, return to the ‘Registration Center’ screen to enter the code to unlock the program features that you purchased.

Set Owner XE "Owner:setting" (s) of Homestead
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The owner(s) of a particular homestead can be set using the “Owner” button found next to the database drop down list.  It’s important to set the owner for the Homestead if you wish to use the ‘View’, ‘Hide animals not ‘Owned’ by this Homestead’.  

Pressing the ‘Owner’ button will display a list of contacts that are designated as ‘Owner’ records.  The first time you use the function the list will be empty.
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Use the ‘New’ button at the bottom left to create the first owner.   The new contact screen allows for up to two contacts if you are using a business name for the main address area.
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After adding one or more ‘owners’ for the homestead, you must also ‘check’ those items in the list to set them as the owner.
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You may have other types of contact records in your Homestead besides ‘Owner’ records.   If you wish to display all contact records, use the drop down list at the top right to select ‘All’.   Once you use a record for a particular type of contact, that record will automatically be updated to indicate that it should be shown for that type of contact.  (Contact records can be used with 1 or more different ‘types’ such as ‘Owner’, ‘Breeder’, ‘Source of Medication’, etc.)
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Backup XE "Backup"  Homestead XE "Homestead:Backing up" 
You can make a backup of your homestead at any point by using the ‘Backup’ item under the ‘File’ menu.   If you have a specific reason for the backup, the description field can be used for that purpose.  (If you do not give a description, the default is “User initiated backup”)
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Northern Hills Software occasionally makes changes to the layout of the database used by Homestead Manager.  When that occurs and prior to an automatic update of your database to the new format, an automatic backup will be made as well.

Automatic Backup XE "Backup:Automatic"  Prompt
When you run Homestead Manager, you will receive a prompt asking if you wish to make a backup of the Homestead.   
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You can say Yes or No and will continue to receive this prompt every time you open the program unless you also select “Don’t show this prompt again”, in which case your answer “Yes” or “No” becomes the default.
If you wish to change this later, go to ‘Tools’, ‘Options’.

Restore Homestead XE "Homestead:Restoring" 
If you wish to delete your current homestead and restore it from a backup, select ‘Restore’ from the ‘File’ menu.
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Select the backup in the list you wish to restore, then press “Select”.   Any current Homestead by that name will be replaced with the backup selected.   If you have more than one Homestead, use the drop down list at the top right to pick which Homestead you wish to restore.

You can also delete backups by selecting one or more items in the list, then pressing the ‘delete’ button at the bottom left.
Run Wizard XE "Wizard:Running" 
When you first create a new Homestead, you will receive the following prompt.
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This allows you to add predefined information to your homestead such as Species, Breeds, Events, Categories, etc.  Regardless of how you respond to this prompt during initial setup, you can also run the wizard for a homestead at any other time using ‘File’, ‘Run Wizard’.    Information already defined in the Homestead will be checked in the lists shown in the Wizard, merely check any other values you wish to add.   Any items you uncheck will be removed from the Homestead unless there are data records in the homestead using that value.
Add Category XE "Adding:Category" 
Categories are a very powerful feature of Homestead Manager.  You can use categories for grouping one to many animals.   Animals may also be defined to more than category at a time.   For example, categories can be a descriptor of the animal (‘Dog’) or actions that need to occur for the animal (‘To be Vaccinated’).

You can add a category from the main Homestead Manager screen by clicking the right mouse button in the category list or from ‘Category’ found on the ‘Add’ menu.   You can also add categories on the Add/Edit Animal screen using the ‘New’ button found under the category list.
Add Animal XE "Adding:Animal" 
You can add a new animal to Homestead Manager using the ‘Add’, ‘Animal’ menu item or by clicking the right mouse button in the Categories or Animal List.  If you do this when you have a specific category selected in the category list, the animal will automatically be assigned to that category on the animal screen.
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Name, Specie and at least one category is required, all other fields are optional or will default.

Name:  You can use this field to specify the ‘common’ name for the animal.   You can also define alternate names elsewhere on this screen.

Specie: You can select a specie from the drop down list or use the ‘New’ or ‘List’ button to add or select the specie of your choice.   After you pick specie, the breeds specific to that specie will appear in the breed list.  Additionally, if you pick a specie that has gestation or heat defined in the specie record and you select ‘Female’ as the gender, Gestation and Heat fields will be displayed beneath the dam/sire fields.
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The values shown will default to values set either in the specie or breed record, but you can override the values to be specific to the animal.  (Do not modify these fields if you wish to use the defaults set in specie or breed)

Breed: This list will be empty until you select the Breed then it will display breeds specifically defined for the specie.  You can add additional breeds using the ‘New’ button.  (+)
Gender: Gender will default to Unknown.  However, a gender must be selected before this animal can be used in a breeding record.   You can also indicate if the animal has been spayed or neutered (fixed).
Active: The ‘Active’ check box will by selected by default.  This indicates that the animal is actively associated with this homestead.  (Deceased animals for example could have the ‘Active’ flag turned off.)   The ‘Hide Animals not Active’ item found under the ‘View’ menu can be used to help unclutter the main animal list by suppressing records of non-active animals.

Born and Died: The ‘Born’ and ‘Died’ buttons allow for a quick addition of a birth or death event for the animal.   The date associated with the event will be display to the right of the button after saving the event.
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 Notes: Press this button to add or edit the note associated with this animal.  The button will be grey if no note is associated with this animal.  Once a note is defined the button will be red. 
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 Owner: The Owner button is used to select one or more owners of the animal.  This is important if you wish to show or hide animals in the main animal list based on association with this homestead.  (See ‘Hide Animals not owned by this Homestead’ found under the ‘View’ menu)

[image: image45.png]


 Breeder: The Breeder button is used to select one or more contact records which associates the breeder for this animal.   

UserRef: User Reference is a value that can contain any information that identifies or describes this animal.  How this field is used it totally by preference of the user.

Dam: The drop down list will display a list of animals for selection of the Dam of this animal.   If this animal is later added to a breeding record, the Dam field will be updated to reflect the value found in the breeding record and will no longer be editable in the animal screen.   You can add a new Dam by using the New button or select from a list using the List button.

Sire The drop down list will display a list of animals for selection of the Sire of this animal.   If this animal is later added to a breeding record, the Sire field will be updated to reflect the value found in the breeding record and will no longer be editable in the animal screen.   You can add a new Sire by using the New button or select from a list using the List button.

Gestation and Heat Cycle: If you select a specie that has gestation or heat information associated with it and you select a gender of ‘Female’, the Gestation and Heat fields will be displayed.   This allows you to set heat or gestation information unique to a particular animal.  Generally you should use the value specified in the Specie or Breed record, but if you have an animal that typically deviates from those values, this option allows you to set it specific to that animal.   (Values set per animal override values set at the breed level with overrides values set at the specie level)

Alternate Names: The name list can be used to define alternate names for the animal.   When you press the New button, you will first be presented with a list of ‘Name Types’ (which are definable by the user) such as ‘Alternate Name’, ‘Registered Name’, etc.  Once you select the type of name, you can then enter the value for the name.
You can show alternate names in the main animal list if you select ‘Show Alternate Names in Animal List’ from the ‘View’ menu.

Identifiers: The identifier list can be used to define items that identify the animal.   When you press the New button, you will first be presented with a list of ‘Identifier Types’ (which are definable by the user) such as ‘AKC #’, ‘Microchip’, Tattoo’, etc.  Once you select the type of identifier, you can then enter the value for the ID.

There are two options found under the ‘View’ menu for displaying Identifiers in the main animal list.

Images: Images can be added to the animal by clicking on the image area.

Categories: At least one category must be selected before you can save the animal information.  You can add additional categories by using the ‘New’ button underneath the category list.

Once the animal record has been added, the main screen will show that animal in the list as well as the information about the animal in the detail lists shown underneath the animal list.   You can now add events, characteristic records, and breeding records to the animal.

Edit Animal XE "Editing:Animal" 
You can edit an animal in the Homestead by doing one of the following:

1. Select the animal in the list and then use the ‘Edit’, ‘Animal’ menu.

2. Click the right mouse button on an animal and selecting ‘Edit’ from the context menu.

3. Double clicking on an animal in the animal list.

4. Select ‘View’, ‘Animals’ from the menu then press the ‘New’ button.
Delete XE "Deleting:Animal"  Animal

You can delete an animal in the Homestead by doing one of the following:

1. Click the right mouse button on an animal and selecting ‘Delete’ from the context menu.

2. Select ‘View’, ‘Animals’ from the menu, select the animal in the list, then press the ‘Delete’ button.

Working with Events XE "Events:Working with" 
Add Event XE "Adding:Event" 
In order to add an event, you must have an animal selected in the animal list on the main screen.  You can then click the right mouse button on the animal in the list to get a pop-up menu to add an event, or you can use the “Add”, “Event” from the menu.   You can also click the right mouse button in the Event list to add another event.
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When adding an event you will be presented with a list of event types from which to select.   If you used the wizard after creating a homestead, you will have a series of predefined events available for selection.   You can also add additional event types from this list by using the “New” button at the bottom left.    (See Working with Event Types for more information.)   Select the event type from the list and press “Select” to continue adding a new event.

Edit Event XE "Editing:Event" 
You can edit an event by selecting the event in the event list panel and using the ‘Edit’, ‘Details’ menu item.   Or select the event in the list and click the right mouse button to get a popup menu where you can select ‘Edit’.
Delete Event XE "Deleting:Event" 
You can delete an event by selecting the event in the event list panel and clicking the right mouse button to get a popup menu where you can select ‘Delete’.
Event Screen

The Event Screen will have a series of tabs with information you can enter, the tabs that are displayed and the fields available for entry are dependent on how the event type was setup.   All events will always have a “General” tab with Type, Date, Location and Comment always available.     Date Fields will always have a calendar and a date calculator button for selecting the date, or you can enter the date directly into the date field.   Values you enter that aren’t recognized as a date are still acceptable and will be treated as ‘freeform’.  Events with a freeform date or no date will sort to the end of the event list on the main screen. 
Event General Tab
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The General tab can have one or more of these fields enabled for data entry depending on what has been enabled for the event type.

Date XE "Date:Event" 
The Date field is used to indicate when the event occurred.   You can use the calendar button to select the date, or the date calculator button to calculate the date based on a from or to date and number of days, months or years from that date.   Values entered into this field that are not recognized as a date are considered ‘freeform’ and will sort to the end of the event list on the main Homestead Manager screen.

End Date XE "End Date:Event" 
The End Date field, if available, is used to indicate when the event ended.   The calendar button can be used to select the date.  Or, the date calculator button can be used to calculate the date based on a from or to date and number of days, months or years from that date.   Values entered into this field that are not recognized as a date are considered ‘freeform’ and will sort to the end of the event list on the main Homestead Manager screen.
Location XE "Location:Event" 
The location field is used to indicate where the event occurred.   You can quickly add more items to the Location list using the ‘New’ button.    Location is a required field for all events.   
Reason XE "Reason:Event" 
The reason field, if available, can be used to indicate the reason for the event.
Comment XE "Comment:Event" 
The comment field can contain any information you wish to associate with the event.
2nd Party XE "2nd Party:Event" 
The 2nd Party list, if available, is used to attach one or more contact records to the event.   In the example on the previous page, we created a “2nd Party” label of “Helper”, but the value you define for each event can be whatever you wish.  (Buyer, Seller, Vet Staff, Shearer, etc.)
Event Characteristics Tab
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The Characteristics tab shows weight information for the animal including all other weight values in other events so you can see trends.

Body Score XE "Body Score:Event" 
You can indicate the weight of the animal at the time of this event in Pounds and Ounces or Kilograms.   Or you can use a generic value indicating the weight of the animal compared to normal.
Event Medication Tab
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The Medication tab can have one or more of these fields enabled for data entry depending on what has been enabled for the event type.

Medication Name XE "Medication Name:Event" 
Medication name is required IF any fields are selected on the medication tab screen.   Use the drop down list to select the medication name, or the “New” or “List” button to add or select a medication.
Route of Administration XE "Route of Administration:Event" 
Route of Administration is the general method for the administration of the medication such as ‘Oral’, ‘Shot’ or ‘Topical’.   Use Delivery Method and Delivery Location to provide additional detail.
Form of Medication XE "Form of Medication:Event" 
Form of Medication is use to describe the medication form such as liquid, paste, pill, powder, etc.
Delivery Method XE "Delivery Method:Event" 
Delivery Method provides detailed information on how the medication was administered.  (Dip, Drench, Intramuscular, Intravenous, Spray, etc.)
Delivery Location XE "Delivery Location:Event" 
Delivery Location indicates where on the animal the medication was applied.  (Left Flank, Mouth, Neck, etc.)
Dosage XE "Dosage:Event" 
Dosage indicates the dose size given to the animal in units. (grams, ounces, pints, milliliter, etc.)
Frequency/Duration XE "Frequency/Duration:Event" 
This field is a ‘freeform’ field that allows you to describe how often or how long the medication should be delivered to the animal.   An example could be ‘3x daily for 1 week’.   If this field is specified, the Dosage information must also be supplied.
Lot Number XE "Lot Number:Event" 
If the medication has a lot number which you would like to track, the information can be entered in this field.
Cost per Treatment XE "Cost per Treatment:Event" 
Allows you to enter the cost of the treatment if applicable.  If this is a ‘shared’ event with multiple animals you can indicate the entire cost across all animals, or enter the cost ‘per animal’.  (Select the ‘Per Animal’ checkbox in that case.)
Source of Medication XE "Source of Medication:Event" 
Source of Medication is a ‘contact’ record that indicates where the medication was obtained.   You can use this either for manufacturer information or the location where it was purchased.  Select an item from the drop down list or use the ‘New’ or ‘List’ button to add a new contact.
Administered by XE "Administered by:Event" 
Administered by is a ‘contact’ record that indicates who administered the medication such as a Vet.
Next Planned Procedure

If this is a medication or procedure that is performed on a regular basis, you can set the date of the ‘Next Planned Procedure’ in this field.
Event Treatment Tab
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The Treatment tab can have one or more of these fields enabled for data entry depending on what has been enabled for the event type.

Symptoms XE "Symptoms:Event" 
Allows you to enter the symptoms the animal exhibited that prompted the treatment.
Diagnosis XE "Diagnosis:Event" 
Allows you to enter the diagnosis information for the condition. 
Treatment XE "Treatment:Event" 
Indicates the treatment applied to the animal.
Shared Events XE "Shared Events" 

 XE "Event:Shared" 
If the event type was set to be a ‘shared’ event, then you can attach the event to multiple animals.   Use the ‘Add’ button at the bottom left to add additional animals to the event.  (The event will automatically be listed under those animals as well.)
Working with Characteristics XE "Characteristics:Working with" 
Add XE "Adding:Characteristics"  Characteristic

In order to add a characteristic record, you must have an animal selected in the animal list on the main screen.  You can then click the right mouse button on the animal in the list to get a pop-up menu to add a characteristic, or you can use “Add”, “Characteristics” from the menu.   You can also click the right mouse button in the Event list to add a characteristic record.

Edit XE "Editing:Characteristics"  Characteristic
You can edit a characteristic record by selecting the characteristic in the event list panel and using the ‘Edit’, ‘Details’ menu item.   Or select the characteristic in the list and click the right mouse button to get a popup menu where you can select ‘Edit’.

Delete XE "Deleting:Characteristics"  Characteristic
You can delete a characteristic by selecting the item in the event list panel and clicking the right mouse button to get a popup menu where you can select ‘Delete’.

Characteristics Tab
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Date XE "Date:Characteristics" 
The Date field is used to indicate when the characteristic record occurred.   You can use the calendar button to select the date, or the date calculator button to calculate the date based on a ‘from’ or ‘to’ date and number of days, months or years from that date.   Values entered into this field that are not recognized as a date are considered ‘freeform’ and will sort to the end of the event list on the main Homestead Manager screen.

Comment XE "Comment:Characteristics" 
The comment field can contain any information you wish to associate with the characteristic record.
Body Score XE "Body Score:Characteristics" 
You can indicate the weight of the animal at the time of this characteristic record in Pounds and Ounces or Kilograms.  Or you can use a generic value indicating the weight of the animal compared to normal.

Dimensions XE "Dimensions:Characteristics" 
The Dimensions fields can be any value you find useful such as “Height at Withers” or “Length of Fiber”.   Use the drop down list to pick an item or use the ‘New’ button to add a new item to the list.  Once you have a dimension selection, you can enter the whole number in the field to the right and the fraction in the drop down list to the right of the whole number.   You can have more than four dimension types defined, but only four can be assigned on each characteristics record.
Color XE "Color:Characteristics" 
Color can be used to describe the color of the animal.
Coat XE "Coat:Characteristics" 
Coat can be used to describe the coat of the animal.
Eye Color XE "Eye Color:Characteristics" 
Eye Color can be used to describe the eye color of the animal.
Fiber XE "Fiber:Characteristics" 
Fiber can be used to describe the fiber quality of the animal.
Working with Milking Records XE "Milking:Working with" 
Add XE "Adding:Milking"  Milking Record

In order to add a milking record, you must first select an animal in the animal list on the main screen.  Then click the right mouse button to get a pop-up menu which will include “Add Milking”.  You can alternatively use “Add”, “Milking” from the main menu.   

Edit XE "Editing:Milking"  Milking Record

You can edit a Milking record by selecting the Milking “season” record (‘MK’) in the event list, then selecting a specific milking record in the details list.  (Use the right mouse button on the specific milking record to display the ‘Edit’ option)  You can also double click on one of the milking records in the details list to edit it.   You may have one or more ‘MK’ records in the event list, each entry symbolizes a milking “season”.  (Milking records separated by more than 30 days)   The date shown on each ‘MK’ record is the first day of the season and the details column will show the total quantity of milk for that season and the number of milking records associated with that season.
Delete XE "Deleting:Milking"  Milking
You can delete a Milking record by first selecting a Milking “season” record (‘MK’) from the event list, then do a right mouse button on a specific Milking record in the details list to display a menu which includes ‘Delete’.   
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Date XE "Date:Milking" 
The Date field is used to indicate when the Milking occurred.  It is the only field on the milking screen that is required.  (Time is optional as well) You can use the calendar button to select the date, or the date calculator button to calculate the date based on a ‘from’ or ‘to’ date and number of days, months or years from that date.   Only ‘exact’ dates may be entered into the date field.
Location XE "Location:Milking" 
The optional location field indicates where the milking occurred.
How XE "How:Milking" 
Indicates the method used for the milking, the default being ‘unspecified’.
Cream XE "Cream:Milking" 
This field indicates the percentage of cream per quantity of milk.
Comment XE "Comment:Milking" 
The comment field can contain any information you wish to associate with the milking record.
Quantity XE "Quantity:Milking" 
First select the unit of measurement for the milking then enter the amount.  You can switch between units once you’ve entered a amount and the program will automatically convert to that unit of measurement although some precision may be lost. 

Milker XE "Milker:Milking" 
This can be used to associate a contact record to the milking event.
Milking Clipboard XE "Clipboard:Milking" 
If you milk multiple animals and wish to more quickly enter the milking records for a single session, use the “Milking Clipboard”.   Select any category from the Categories list then press the right mouse button to display a pop-up menu in order to select “Milking Clipboard”.   The animals that can be selected on the clipboard depend on the category you selected. 
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Same as the Milking screen, the clipboard requires a date although time is optional.  The date will be used for all animals entered.   Additionally, the value you select for “How” will also be used for all animals unless overridden.   The “Milker” contact records can be set as a default for all animals but can also be overridden per animal.

You can add up to 99 animals per clipboard, as you fill up one screen the ‘Page’ buttons will automatically adjust so you can switch between pages of selected animals.    (Nothing will be added to the database until you press the “OK” button)
Once an animal has been selected in a drop down list, it will no longer be available for selection in the other drop down lists.
Query (Find) Milking records XE "Query:Milking" 
To find one or more Milking records, use the “Query”, “Milking” main menu item.  For the query, there are multiple tabs that allow you to select the filtering criteria for selecting the Milking records.  By default, all tabs will be ‘disabled’ except for the Animals tab.  Tabs can be enabled or disabled by using the “Do not filter using above criteria” check box.   Selecting the checkbox when a specific tab is selected will disable filtering for that type of information.  If you enter information on multiple tabs, ALL criteria must be met for a particular Milking record to be shown in the results list.
Animals Tab XE "Query:Milking Animals" 
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If this tab is enabled you can select one or more animals to filter the results of the Milking records.    Use the check box next to a animal to select it as part of the query.  The two ‘Hide’ options can be used to control what animals appear in the list for selection.   If you select multiple animals, then Milking records for each of the animals will be eligible for selection during the query.
If you select the “Do not filter using above criteria (Animals)” checkbox, then all animals with Milking records will be examined during the query.
Date Tab XE "Query:Milking Date" 
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If this tab is enabled you can select a date or date range for filtering the results of the Milking records.    Select the Date Modifier first to determine how the date will be used and if multiple dates must be entered.

If you select the “Do not filter using above criteria (Date)” checkbox, then the Milking records will not be filtered by date during the query.

Locations Tab XE "Query:Milking Locations" 
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If this tab is enabled you can select one or more locations for filtering the results of the Milking records.    If more than one location is selected, the Milking records that match any of the selected values will be eligible during the query.

If you select the “Do not filter using above criteria (Locations)” checkbox, then the Milking records will not be filtered by location during the query.

Quantity Tab XE "Query:Milking Quantity" 
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If this tab is enabled you can select a quantity or quantity range for filtering the results of the Milking records.    Select the Quantity Modifier first to determine how the quantity will be used and if multiple quantities must be entered.

If you select the “Do not filter using above criteria (Quantity)” checkbox, then the Milking records will not be filtered by quantity during the query.

How Tab XE "Query:Milking How" 
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If this tab is enabled you can select one or more methods of milking for filtering the results of the Milking records.    If more than one method is selected, Milking records that match any of the selected values will be eligible during the query.

If you select the “Do not filter using above criteria (How)” checkbox, then the Milking records will not be filtered by method during the query.

Get Results

After selecting the values for filtering on the various tabs, press the “Get Results” button to show Milking records that match the specified values.   You can edit any Milking record that is displayed in the results list by double clicking on it or by selecting it and using the “Edit” button.   You can also delete a Milking record by selecting an item in the result list then pressing the “Delete” button.
Add Breeding XE "Breeding:Adding" 

 XE "Adding:Breeding"  Information
To add new breeding information to a Dam or Sire, select the animal in the animal list on the main screen and click the right mouse button to display popup menu to select ‘Add Breeding’.  You may also use ‘Breeding’ from the main ‘Add’ menu after selecting the animal in the list.
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If you add a breeding record to a Dam, the Dam will automatically be shown in the Dam list and the Sire will need to be selected.   If you add a breeding record to a Sire, the opposite will occur.

Sire Information

Sire XE "Sire:Breeding" 
Use the ‘New’ button to the right of the sire field to add a new sire not already in the database, or use the ‘List’ button to select a Sire that does exist.   The species of the Dam will limit what is shown in the list to animals with compatible species.
Sire Notes XE "Sire Notes:Breeding" 
The Note button to the right of the sire information can be used to add information such as breeding notes applicable to the sire.   (Don’t add notes about the Dam using this field)
Sire Owners XE "Sire Owners:Breeding" 
Next to the Sire Note button is a button for entering the owners of the sire at the time of the breeding.   The current owners of the Sire will automatically be selected if a Sire has been specified, but you can override those values using this button.
Fee XE "Fee:Breeding" 
Next to the Sire Owner button is a drop down field you can use to select “Received” or “Paid” if a fee was involved with the breeding.   Use the field to the right of the dropdown to enter the amount.
Type XE "Type:Breeding" 
Allows you to select the type of breeding. ‘Unknown’ is the default if nothing is selected.
Location XE "Location:Breeding" 
This is a required field and indicates the location of the breeding.  This can be as specific or general as you like.
Date XE "Date:Breeding" 
Date and time of the breeding.   If the Sire is left with the Dam(s) for an extended period of time, this can be thought of as the ‘Start’ time.
Removed XE "Removed:Breeding" 
Date and Time that the Sire was separated from the Dam(s).
Behavior XE "Behavior:Breeding" 
Information relating to how the Sire responded to the Dam(s).
Dam Information

You can have multiple dams per breeding.  Use the ‘Add’ button at the bottom left to select a dam to be added to the list.   You can also remove dams from the list using the ‘Delete’ button.  This does not remove the animal from the Homestead.  It only removes the dam from the breeding record.

Dam Notes XE "Dam Notes:Breeding" 
The Dam Notes button is at the bottom right of the Dam list and can be used to add information applicable to the Dam and the breeding.   Notes are per dam, so first select the animal in the list to enter the notes for that dam.
Dam Owners XE "Dam Owners:Breeding" 
The owners of the dam at the time of breeding can be selected using the owner button at the bottom right of the Dam list.  The current owners are automatically selected but you can override that value using this button.  The owners are per dam.  Select the animal in the list to select owners for that dam.
Heat Cycle Tab
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If the species record for the animal has ‘heat’ information, you can add heat dates on the ‘Heat cycle” tab.

1st Heat, 2nd Heat, etc.

You must enter heat dates in order, if ‘1st Heat’ is not specified, ‘2nd Heat’ cannot be entered.  Use the ‘Calendar’ button next to the heat field to select the date of the heat.  The ‘Next Heat’ and ‘Full Range’ fields will be calculated based on the heat values in the specie or breed record after entering a value into the ‘1st, 2nd, etc.’ heat field.
Next Heat

The ‘Next Heat’ will calculate the next projected heat using the ‘Average’ value specified for the animal.   (If heat is specified for animal, that will override any value specified in the breed record which overrides any value specified in the specie record)
Full Range

The ‘Full Range’ will calculate the next projected heat using ‘Minimum’ and ‘Maximum’ values if specified.   If only ‘Average’ is specified, the ‘Full Range’ value will be the same as ‘Next Heat’.
Results Tab
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For each dam you can provide gestation results by first selecting the dam in the dam list, then, on the results tab, you can select the current state of the breeding.   The value selected on the ‘Results’ tab will determine what is available on the ‘Gestation’ tab.
Unconfirmed XE "Unconfirmed:Breeding" 
This indicates that the status of the breeding is unknown for this animal.   If this is selected, no additional useful information is displayed on the ‘Gestation’ tab.
Confirmed XE "Confirmed:Breeding" 
This indicates that the animal has been confirmed as pregnant.  Once this is selected, a ‘Conception Date’ will be available for entry.  If a ‘Start’ date, ‘Removed’ date or ‘Conception’ Date is entered and the specie has gestation information, the ‘Gestation’ tab will show an estimated gestation period.
Delivered XE "Delivered:Breeding" 
This indicates that the dam gave birth.   A delivered date and location will be available along with the conception date.   Additionally, the animals born for this breeding can be entered using the ‘New’ button.   You can also select animals already entered in the homestead as offspring in case you previously had the animal defined but not yet associated with a breeding.   When adding offspring, you will also need to provide details for the ‘born’ record to be added to each animal and optionally weight information.   If there were any stillborn animals you can enter a count at the bottom right of the offspring list.
Note: If you select an already existing animal in the homestead for the offspring list, the ‘born’ information you enter will override any ‘born’ event already defined.   Additionally, any information that animal has entered for dam and sire will be replaced with the dam and sire shown in the breeding record.
Miscarried XE "Miscarried:Breeding" 
Selecting this type will allow for a miscarried date and location to be entered, but no offspring information.
Aborted XE "Aborted:Breeding" 
Selecting this type will allow for an aborted date and location to be entered, but no offspring information.
Not Pregnant XE "Not Pregnant:Breeding" 
This indicates that the animal has been confirmed as not pregnant, and no additional breeding information need be entered for that dam.

Reminders Tab
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If the animal results status is set to “Confirmed”, the “Reminders Tab” will show various reminder dates as specified in the species record.   If the program is able to calculate a due data, for example if ‘Conception Date’ is specified, then reminder dates will be shown for each of the items in the list.  (You can have up to 5 reminders, the species record has fields for indicating the reminder text and the number of days prior to the due date that the reminder is applicable)
Gestation XE "Gestation:Breeding"  Tab

The information on the gestation tab depends if ‘Start’, ‘Removed’ or ‘Conception’ date has been entered and if the dam species has minimum, average, and maximum gestation information defined.
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In this example a ‘Conception’ date and the gestation values for the species indicate a possible delivery date in 121 to 145 days from the current date.   A yellow bar indicates that the animal, relative to the current date, is early for delivery.  A green bar indicates the animal could be due for delivery at any time.  A red bar indicates that the animal is likely overdue for delivery.  (The bar will ‘grow’ as the date gets further from the conception date)
Breed and Animal fields show gestation values if specified at that level.  (In the above example, the breed record and the animal record do not have any values specified)
If the Dam has previous breeding experiences, those values will be calculated to generate a minimum, average, and maximum gestation period which can be used for the display be selecting the ‘Dam’ button.

If this Dam/Sire combination has previous breeding experiences, those values will be calculated to generate a minimum, average and maximum gestation period which can be used for the display by selecting the ‘Dam /Sire’ button.
Working with Identifiers (IDs) XE "Identifiers (IDs):Working with" 
Add XE "Adding:ID"  ID

In order to add an ID record, you must have an animal selected in the animal list on the main screen.  You can then click the right mouse button on the animal in the list to get a pop-up menu to add an ID, or you can use ‘Add’, ‘ID’ from the menu.   You can also click the right mouse button in the Event list to add an ID record.
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When adding an ID, you will be presented with a list of ID types to select from.   If you used the wizard after creating a homestead, you will have a series of predefined IDs available for selection.   You can also add additional ID types from this list by using the “New” button at the bottom left.  Select the ID type from the list and press “Select” to continue adding a new ID.

Edit XE "Editing:ID"  ID

You can edit an ID record by selecting the ID in the event list panel and using the ‘Edit’, ‘Details’ menu item.   Optionally, select the ID in the list and click the right mouse button to get a popup menu where you can select ‘Edit’.

Delete XE "Deleting:ID"  ID

You can delete an ID by selecting the item in the event list panel and clicking the right mouse button to get a popup menu where you can select ‘Delete’.

Working with Names XE "Names:Working with" 
Add XE "Adding:Name"  Name

In order to add a Name record, you must have an animal selected in the animal list on the main screen.  You can then click the right mouse button on the animal in the list to get a pop-up menu to add a Name, or you can use ‘Add’, ‘Name’ from the menu.   You can also click the right mouse button in the Event list to add a Name record.
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When adding a Name, you will be presented with a list of Name types to select from.   If you used the wizard after creating a homestead, you will have a series of predefined Names available for selection.   You can also add additional Name types from this list by using the “New” button at the bottom left.  Select the Name type from the list and press “Select” to continue adding a new Name.

Edit XE "Editing:Name"  Name

You can edit a Name record by selecting the Name in the event list panel and using the ‘Edit’, ‘Details’ menu item.  Optionally, select the Name in the list and click the right mouse button to get a popup menu where you can select ‘Edit’.

Delete XE "Deleting:Name"  Name

You can delete a Name by selecting the item in the event list panel and clicking the right mouse button to get a popup menu where you can select ‘Delete’.

Show Animal XE "Identifers:Showing in Animal List"  Identifiers in Animal List

If you find that identifiers are a method from which you pick an animal from the animal list on the main Homestead Manager screen, you can elect to show IDs in the animal list.   On the ‘View’ menu are two different methods for showing IDs in the animal list - both of which can be used at the same time.

ID [Type]

This method shows the ID value first, and then the ID Type in brackets following it.
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[Type] ID

This method shows the ID Type first in brackets, and then the ID value following it.
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Note:  Selecting then deleting an Identifier in the Animal list will delete the animal.  If you want to delete just the identifier, select it in the ‘Event’ list to delete.
Show Alternate Names XE "Alternate Names:Showing in Animal List"  in Animal List

If you want the animal alternate names to be in the animal list on the main Homestead Manager screen, use the ‘View’, ‘Show Alternate Names in Animal List’ menu to do this.

Note:  Selecting then deleting an Alternate Name in the Animal list will delete the animal.  If you want to delete just the Alternate Name, select it in the ‘Event’ list to delete.
Working with Species XE "Species:Working with" 
Add XE "Adding:Species"  Species
You can use the ‘Wizard’ to add predefined information to your homestead such as species, or you can add species from the ‘Add’, ‘Specie’ menu.   Additionally some actions such as adding or editing an animal will allow adding species from the location where it’s used.
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The specie screen allows you to enter the name of the specie and a description.   You can also define the names you wish to use in place of ‘Dam’ or ‘Sire’ as well as the specie applicable to each.  (For example, a Mule is the offspring of a male donkey and a female horse)   You can also specify the number of days typical for gestation or heat cycle within that specie.  The Breeding reminder fields allow you to enter up to 5 reminders and the number of days before the due date that the reminder is applicable.  You must specify gestation information in order to enter Heat Cycle or Reminders.

If this specie is eligible for “Milking” records, select that under the “Options” section.
Edit XE "Editing:Species"  Specie

You can edit a Specie record using the ‘View’, ‘Lists’, ‘Species’ menu.   You will be presented with a list of species which can be selected for editing.

Delete XE "Deleting:Species"  Specie
You can delete a Specie record using the ‘View’, ‘Lists’, ‘Species’ menu.   You will be presented with a list of species which can be selected for deletion.   If the specie is used by an animal in your Homestead, you will be prevented from deleting the record.

Working with Contacts XE "Contacts:Working with"  
Many of the Homestead Manager screens (events, animals) have contact information 

on it that can be identified by one of the following methods:

	Contact Button
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	Contact Dropdown list
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When the Contact Button is available, hover the mouse pointer over the button to see a ‘Tip’ that tells you the type of contact (eg. Owner) and the names of any contacts already assigned to this value.   Pressing the button will take you to the contact screen for selection.

With a Contact Dropdown list, select the contact you wish from the list or press the ‘New’ button to quickly add another or the ‘List’ button to get more detailed information about each contact in the dropdown list.

With the Contact List, press the ‘New’ Button to add a new contact, or select an item in the list and press the ‘Edit’ or ‘Delete’ button or press the ‘List’ button to work with all contacts.

List of Contacts XE "Contacts:Listing" 
When viewing a contact list, you can switch from a list of specific contact types to a list showing all contacts by using the selection dropdown at the top right of the display.
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If you used the ‘View’, ‘Lists’, ‘Contacts’ to display the contact list, you will see all contact types in the dropdown list.
Homestead Manager identifies a contact by its usage.   Contacts that have been used as ‘Source of Medication’ will not show up in the ‘Owner’ list unless that contact has been assigned to an owner as well.   By default, when adding a new contact, it will only be assigned to the specific contact type you are creating.   However, when using other types of contacts such as ‘Owners’, if you change the list display to show ‘All’ and then use a ‘Source of Medication’ contact as an owner, it will from that point forward be associated with both contact types.    Contacts can be associated with any or all of the contact types.
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Set Animal XE "Active:Setting Animal"  as Active or Inactive

If an animal in your Homestead is no longer ‘active’ (dead, sold, etc.), you can indicate this from the ‘Edit’, ‘Animal’ screen.   Check or uncheck the ‘Active’ check box based on status.

Hide animals not active

One way to help manage the number of animals shown in the animal list on the Homestead Manager screen is to hide animals no long active.    Use ‘View’, ‘Hide Animals not active’ from the menu to hide the inactive animals.
Set Owner XE "Owner:Animal"  of Animal
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Setting the owner of the animal can be accomplished from the ‘Edit’, ‘Animal’ screen by pressing the owner button.   It is recommended that you set the owner so that you can properly use the ‘Hide Animals not owned by this Homestead’ feature.
Hide Animals not owned by Homestead

If the owner(s) of the Homestead have been set and the owner(s) of the animals are also set, you can hide those not owned by the Homestead in the animal list on the main Homestead Manager screen.   Use the ‘View’, ‘Hide Animals not Owned by this Homestead’ menu item.
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Set Breeder XE "Breeder:Animal"  of Animal
You can set the breeder of the animal using the ‘Breeder’ button on the ‘Edit’, ‘Animal’ screen.
View list of all animals XE "Animals:View List" 
Animals may be hidden in the main animal list in Homestead Manager based on options set in the ‘View’ menu.   You can see all animals in the database along with pertinent information by using ‘View’, “Animals’ from the menu.

Working with Locations XE "Locations:Working with" 
You can view a list of all locations in the Homestead using the ‘View’, ‘Lists’, ‘Locations’ menu item.   You can add or edit locations from this list.  You can also delete locations as long as they are not in use by the Homestead.
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Submit question or request for enhancement XE "Request for enhancement" 
If you have an idea for a enhancement to the program or have a question, you can easily send this information to Northern Hills Software using the ‘Help’, ‘Ask a question or suggest a program enhancement’ menu item.    Make sure that the email entered is correct else we will be unable to contact you with a response.
Options XE "Options:Setting"  screen
Use the ‘Tools’, ‘Options’ menu item to get to the Options screen.
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You can set how often ‘Check for Update’ occurs as well as the prompt level for some of the options available to the program.  (Such as ‘Warn when Animal’s gender is set to “Unknown”’)  To change a value in the list, select the item in the list then click ‘Yes’, ‘No’, or ‘Prompt’.
Resizing screens XE "Screens:Resizing" 
Most screens in Homestead Manager allow you to resize them to make them larger.  Hover the mouse pointer over the screen border to get the ‘double arrow’ cursor, then hold down the left mouse button and drag the mouse to resize the window.
Changing size of the “panels” in the main window

The 5 panels found in the main window can also be resized/adjusted to better fit how you wish to see the data.   Hover the mouse pointer over the separator area between two panels until you get a ‘splitter’ cursor, then hold down the left mouse button and drag the mouse to adjust the size.  When you press the mouse button, a solid bar will be shown between the two panels for help in visualizing the adjustment.
About XE "About" 
Use the ‘Help, ‘About’ menu item to display the about screen.   This screen has handy buttons for items on the Northern Hills Software website that you may find useful.
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Date Calculator XE "Date Calculator" 
The date calculator can be used to determine a target date based on a date plus an adjustment to that date by years, months or days.   Any screen that allows for entering a date will have a push button for the date calculator.   If the date field is set, that value will be prefilled in the date at the top of the date calculator.  (Otherwise it will be the current date.)  Enter the number of days, months or years (any combination) and press the plus or minus button to calculate the target date.  If you press ‘OK’, the target date will be populated in the date field from whence you came.
Working with Event Types XE "Event Types:Working with" 
When you run the ‘Wizard’, event types applicable to the species you select will be automatically added to your Homestead.    You can also add event types manually whenever you add a new event or by going to the ‘View’, ‘Lists’, ‘Event Types’ menu item.  First you will be shown a list of event types currently defined to the Homestead.
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You can edit the current event types or delete ones that are not in use.  Use the ‘New’ button to add a new Event Type.
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Enter the name of the event type in the ‘type’ field.  For example, ‘Born’, ‘Died’, ‘Sold’ or ‘Trip to Vet’ could be possible values.   Next select the classification of the event from either the ‘Life Cycle’ or the ‘Animal Care’ section.   If it is an ‘Acquisition’ type, you can flag it as a ‘Born’ event.  ‘Born’ events have special properties, only one ‘Born’ event type can be defined per animal for example.    If the type is a ‘Termination’ event, you can flag it as a ‘Died’ event if applicable.

Once you have the Classification selected, check the items under ‘Uses these fields’ that are applicable to this type of event.   What you select will determine what ‘tabs’ appear for the event when you add that event type to an animal.   You can easily come back later and select additional fields for a previously defined event type, but deselecting a field can cause that information to be lost in events of that event type that use that field.

If this is an event type that can be assigned to more than one animal at a time (linking that event information to multiple animals), select the ‘Shared Event’ option.
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Working with Images XE "Images:Working with" 
On the ‘Edit’, ‘Animal’ screen, the image window will have the words “Click to add Image” if there are no images associated with the animal.  (After an image is selected and is displayed in this window, you still click that area to manage the images.)  Clicking this area will bring up the images screen for managing one to many images for the animal.
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The images screen is divided into two areas.   The top part has information regarding a specific image, and the bottom part has a list of images defined for the animal.   In the above example, you are automatically placed in ‘edit’ mode for an image since there are no images yet defined.    Click on the image area to get a selection box to pick the image.   After you select an image, it will be display in this area, the filename will be display at the top, and any EXIF XE "EXIF:Images"  information attached to the image will be shown in the list to the right.
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Date, Location and description are fields that can be populated for the image.  The description field will automatically be populated with the name of the file, but you may want to replace that with a description of the image.  After you have the information entered, click the ‘Apply’ button to add to the animal.  This will cause the image information to be added to the list at the bottom and will turn off ‘editing’ for this image.   If you wish to make changes, use the ‘edit’ button at the bottom to re-enable the fields.   If you wish to add another image, use the ‘New’ button at the bottom left.
Only one image can be defined as the ‘primary’ image.  This is the image that is displayed on the main Homestead Manager screen for the animal.  Use the ‘Primary’ button (asterisk) to set the primary image if more than one is in the list.  This is done  by selecting the image in the list and clicking the asterisk button. 
Working with Reports XE "Reports:Working with" 
Report Options

Some of the reports allow you to select the type of data that will appear on the selected report.  
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By default, most options will be automatically selected when you run the report, uncheck the items you do not wish to include on the report.

Summary

A summary of all animals shown in the report will be displayed at the top of the report in a table.  This is not available with the “By Animal” report since only one animal will be shown.

Details

Un-checking this option will disallow selection of any of the options under “Include” or “Show Details”. 
Record Identification Numbers (RIN)

Selecting this option will show the internal Homestead Manager ID for some of the types of records.  This may be useful to help distinguish animals with the same name, for example.

Unpopulated Fields

Selecting this option will display all fields for the various types of records even if there is no data entered in that filed.   Un-checking this item will suppress those fields on the report.
All Data Reports XE "Reports:All Data" 
The ‘All Data’ report will create a file with all data in the Homestead.  (With the exception of Breeding records and images which will be added later.)   Use the ‘Reports’, ‘All Data’ menu item to create the report which will be displayed in your internet browser.
By Animal Report XE "Reports:By Animal" 
If you wish to see all information about an animal (except for breeding records and images which will be added later)  use the ‘Reports’, ‘By Animal’ menu after selecting the desired animal in the list.   The report will be shown in your internet browser.
By Category Report XE "Reports:By Category" 
If you wish to see all information about animals in a category (except for breeding records and images which will be added later)  use the ‘Reports’, ‘By Categoryl’ menu after selecting the desired category in the list.   The report will be shown in your internet browser.
Pedigree (Basic) report XE "Reports:Pedigree" 
If you want to see a Pedigree report for an animal, use the ‘Reports’, ‘Basic Pedigree’ menu item after selecting the animal in the list.  The report will be shown in your internet browser.
Open previous reports XE "Reports:Opening previously generated" 
Reports that you have produced will remain on your computer until you delete then.  If you wish to view (or delete) a previously generated report, use the ‘Reports’, ‘Open’ to get a ‘open’ dialog with the list of all generated reports shown in a list.  Select an open from the list and press ‘Open’ to view it, or select one or more items in the list then click the right mouse button to get a popup menu to delete them.   

Note: The name of the report will identify the homestead name, the type of report and the animal if applicable.

Appendix
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Appendix
A
FreeImage License
Homestead Manager uses imaging routines from the FreeImage image conversion library.  As stipulated by use of these routines, the FreeImage license is included below.

FreeImage Public License - Version 1.0

---------------------------------------------

1. Definitions.

1.1. "Contributor" means each entity that creates or contributes to the creation of Modifications.

1.2. "Contributor Version" means the combination of the Original Code, prior Modifications used by a Contributor, and the Modifications made by that particular Contributor.

1.3. "Covered Code" means the Original Code or Modifications or the combination of the Original Code and Modifications, in each case including portions thereof.

1.4. "Electronic Distribution Mechanism" means a mechanism generally accepted in the software development community for the electronic transfer of data.

1.5. "Executable" means Covered Code in any form other than Source Code.

1.6. "Initial Developer" means the individual or entity identified as the Initial Developer in the Source Code notice required by Exhibit A.

1.7. "Larger Work" means a work which combines Covered Code or portions thereof with code not governed by the terms of this License.

1.8. "License" means this document.

1.9. "Modifications" means any addition to or deletion from the substance or structure of either the Original Code or any previous Modifications. When Covered Code is released as a series of files, a

Modification is:

A. Any addition to or deletion from the contents of a file containing Original Code or previous Modifications.

B. Any new file that contains any part of the Original Code or previous Modifications.

1.10. "Original Code" means Source Code of computer software code which is described in the Source Code notice required by Exhibit A as Original Code, and which, at the time of its release under this License is not already Covered Code governed by this License.

1.11. "Source Code" means the preferred form of the Covered Code for making modifications to it, including all modules it contains, plus any associated interface definition files, scripts used to control

compilation and installation of an Executable, or a list of source code differential comparisons against either the Original Code or another well known, available Covered Code of the Contributor's choice. The Source Code can be in a compressed or archival form, provided the appropriate decompression or de-archiving software is widely available for no charge.

1.12. "You" means an individual or a legal entity exercising rights under, and complying with all of the terms of, this License or a future version of this License issued under Section 6.1. For legal entities, "You" includes any entity which controls, is controlled by, or is under common control with You. For purposes of this definition, "control" means (a) the power, direct or indirect, to cause the

direction or management of such entity, whether by contract or otherwise, or (b) ownership of fifty percent (50%) or more of the outstanding shares or beneficial ownership of such entity.

2. Source Code License.

2.1. The Initial Developer Grant.

The Initial Developer hereby grants You a world-wide, royalty-free, non-exclusive license, subject to third party intellectual property claims:

(a) to use, reproduce, modify, display, perform, sublicense and distribute the Original Code (or portions thereof) with or without Modifications, or as part of a Larger Work; and

(b) under patents now or hereafter owned or controlled by Initial Developer, to make, have made, use and sell ("Utilize") the Original Code (or portions thereof), but solely to the extent that

any such patent is reasonably necessary to enable You to Utilize the Original Code (or portions thereof) and not to any greater extent that may be necessary to Utilize further Modifications or

combinations.

2.2. Contributor Grant.

Each Contributor hereby grants You a world-wide, royalty-free, non-exclusive license, subject to third party intellectual property claims:

(a) to use, reproduce, modify, display, perform, sublicense and distribute the Modifications created by such Contributor (or portions thereof) either on an unmodified basis, with other Modifications, as Covered Code or as part of a Larger Work; and

(b) under patents now or hereafter owned or controlled by Contributor, to Utilize the Contributor Version (or portions thereof), but solely to the extent that any such patent is reasonably necessary to enable You to Utilize the Contributor Version (or portions thereof), and not to any greater extent that

may be necessary to Utilize further Modifications or combinations.

3. Distribution Obligations.

3.1. Application of License.

The Modifications which You create or to which You contribute are governed by the terms of this License, including without limitation Section 2.2. The Source Code version of Covered Code may be distributed only under the terms of this License or a future version of this License released under Section 6.1, and You must include a copy of this License with every copy of the Source Code You distribute. You may not offer or impose any terms on any Source Code version that alters or

restricts the applicable version of this License or the recipients' rights hereunder. However, You may include an additional document offering the additional rights described in Section 3.5.

3.2. Availability of Source Code.

Any Modification which You create or to which You contribute must be made available in Source Code form under the terms of this License either on the same media as an Executable version or via an accepted Electronic Distribution Mechanism to anyone to whom you made an Executable version available; and if made available via Electronic Distribution Mechanism, must remain available for at least twelve (12) months after the date it initially became available, or at least six (6) months after a subsequent version of that particular Modification has been made available to such recipients. You are responsible for ensuring that the Source Code version remains available even if the Electronic Distribution Mechanism is maintained by a third party.

3.3. Description of Modifications.

You must cause all Covered Code to which you contribute to contain a file documenting the changes You made to create that Covered Code and the date of any change. You must include a prominent statement that the Modification is derived, directly or indirectly, from Original Code provided by the Initial Developer and including the name of the Initial Developer in (a) the Source Code, and (b) in any notice in an Executable version or related documentation in which You describe the origin or ownership of the Covered Code.

3.4. Intellectual Property Matters

(a) Third Party Claims.

If You have knowledge that a party claims an intellectual property right in particular functionality or code (or its utilization under this License), you must include a text file with the source code distribution titled "LEGAL" which describes the claim and the party making the claim in sufficient detail that a recipient will know whom to contact. If you obtain such knowledge after You make Your Modification available as described in Section 3.2, You shall promptly modify the LEGAL file in all copies You make

available thereafter and shall take other steps (such as notifying appropriate mailing lists or newsgroups) reasonably calculated to inform those who received the Covered Code that new knowledge has been obtained.

(b) Contributor APIs.

If Your Modification is an application programming interface and You own or control patents which are reasonably necessary to implement that API, you must also include this information in the LEGAL file.

3.5. Required Notices.

You must duplicate the notice in Exhibit A in each file of the Source Code, and this License in any documentation for the Source Code, where You describe recipients' rights relating to Covered Code. If You created one or more Modification(s), You may add your name as a Contributor to the notice described in Exhibit A. If it is not possible to put such notice in a particular Source Code file due to its

structure, then you must include such notice in a location (such as a relevant directory file) where a user would be likely to look for such a notice. You may choose to offer, and to charge a fee for, warranty, support, indemnity or liability obligations to one or more recipients of Covered Code. However, You may do so only on Your own behalf, and not on behalf of the Initial Developer or any Contributor. You must make it absolutely clear than any such warranty, support, indemnity or

liability obligation is offered by You alone, and You hereby agree to indemnify the Initial Developer and every Contributor for any liability incurred by the Initial Developer or such Contributor as a result of

warranty, support, indemnity or liability terms You offer.

3.6. Distribution of Executable Versions.

You may distribute Covered Code in Executable form only if the requirements of Section 3.1-3.5 have been met for that Covered Code, and if You include a notice stating that the Source Code version of the Covered Code is available under the terms of this License, including a description of how and where You have fulfilled the obligations of Section 3.2. The notice must be conspicuously included in any notice in an Executable version, related documentation or collateral in which You

describe recipients' rights relating to the Covered Code. You may distribute the Executable version of Covered Code under a license of Your choice, which may contain terms different from this License,

provided that You are in compliance with the terms of this License and that the license for the Executable version does not attempt to limit or alter the recipient's rights in the Source Code version from the rights set forth in this License. If You distribute the Executable version under a different license You must make it absolutely clear that any terms which differ from this License are offered by You alone, not by the Initial Developer or any Contributor. You hereby agree to indemnify the Initial Developer and every Contributor for any liability incurred by the Initial Developer or such Contributor as a result of any such terms You offer.

3.7. Larger Works.

You may create a Larger Work by combining Covered Code with other code not governed by the terms of this License and distribute the Larger Work as a single product. In such a case, You must make sure the requirements of this License are fulfilled for the Covered Code.

4. Inability to Comply Due to Statute or Regulation.

If it is impossible for You to comply with any of the terms of this License with respect to some or all of the Covered Code due to statute or regulation then You must: (a) comply with the terms of this License to the maximum extent possible; and (b) describe the limitations and the code they affect. Such description must be included in the LEGAL file described in Section 3.4 and must be included with all distributions of the Source Code. Except to the extent prohibited by statute or regulation, such description must be sufficiently detailed for a recipient of ordinary skill to be able to understand it.

5. Application of this License.

This License applies to code to which the Initial Developer has attached the notice in Exhibit A, and to related Covered Code.

6. Versions of the License.

6.1. New Versions.

Floris van den Berg may publish revised and/or new versions of the License from time to time. Each version will be given a distinguishing version number.

6.2. Effect of New Versions.

Once Covered Code has been published under a particular version of the License, You may always continue to use it under the terms of that version. You may also choose to use such Covered Code under the terms of any subsequent version of the License published by Floris van den Berg

No one other than Floris van den Berg has the right to modify the terms applicable to Covered Code created under this License.

6.3. Derivative Works.

If you create or use a modified version of this License (which you may only do in order to apply it to code which is not already Covered Code governed by this License), you must (a) rename Your license so that the phrases "FreeImage", `FreeImage Public License", "FIPL", or any confusingly similar phrase do not appear anywhere in your license and (b) otherwise make it clear that your version of the license contains terms which differ from the FreeImage Public License. (Filling in the name of the Initial Developer, Original Code or Contributor in the notice described in Exhibit A shall not of themselves be deemed to be modifications of this License.)

7. DISCLAIMER OF WARRANTY.

COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE COVERED CODE IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE COVERED CODE IS WITH YOU. SHOULD ANY COVERED CODE PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY OTHER CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY COVERED CODE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER.

8. TERMINATION.

This License and the rights granted hereunder will terminate automatically if You fail to comply with terms herein and fail to cure such breach within 30 days of becoming aware of the breach. All sublicenses to the Covered Code which are properly granted shall survive any termination of this License. Provisions which, by their nature, must remain in effect beyond the termination of this License shall survive.

9. LIMITATION OF LIABILITY.

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL THE INITIAL DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OF COVERED CODE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR LOSSES, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY RESULTING FROM SUCH PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS DO NOT ALLOW THE

EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THAT EXCLUSION AND LIMITATION MAY NOT APPLY TO YOU.

10. U.S. GOVERNMENT END USERS.

The Covered Code is a "commercial item," as that term is defined in 48 C.F.R. 2.101 (Oct. 1995), consisting of "commercial computer software" and "commercial computer software documentation," as such terms are used in 48 C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users acquire Covered Code with only those rights set forth herein.

11. MISCELLANEOUS.

This License represents the complete agreement concerning subject matter hereof. If any provision of this License is held to be unenforceable, such provision shall be reformed only to the extent necessary to make it enforceable. This License shall be governed by Dutch law provisions (except to the extent applicable law, if any, provides otherwise), excluding its conflict-of-law provisions. With respect to disputes in which at least one party is a citizen of, or an entity chartered or registered to do business in, the The Netherlands: (a) unless otherwise agreed in writing, all disputes relating to this License (excepting any dispute relating to intellectual property rights) shall be subject to final and binding arbitration, with the losing party paying all costs of arbitration; (b) any arbitration relating to this Agreement shall be held in Almelo, The Netherlands; and (c) any litigation relating to this Agreement shall be subject to the jurisdiction of the court of Almelo, The Netherlands with the losing party responsible for costs, including without limitation, court costs and reasonable attorneys fees and expenses. Any law or regulation which provides that the language of a contract shall be construed against the drafter shall not apply to this License.

12. RESPONSIBILITY FOR CLAIMS.

Except in cases where another Contributor has failed to comply with Section 3.4, You are responsible for damages arising, directly or indirectly, out of Your utilization of rights under this License, based

on the number of copies of Covered Code you made available, the revenues you received from utilizing such rights, and other relevant factors. You agree to work with affected parties to distribute

responsibility on an equitable basis.

EXHIBIT A.

"The contents of this file are subject to the FreeImage Public License Version 1.0 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://home.wxs.nl/~flvdberg/freeimage-license.txt

Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License.
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Copyright and Terms of Use 

Homestead Manager™ is the copyrighted work of Northern Hills Software LLC. Use of the Software is governed by the terms of the end user license agreement, if any, which accompanies or is included with the Software ("License Agreement").  An end user who is willing to use the Software agrees to the License Agreement terms. The copyright is owned by Northern Hills Software LLC. In no event shall Northern Hills Software LLC be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of use, data or profits arising out of or in connection with the use or performance of the Software.

Any rights not expressly granted herein are reserved.

(C) 2008-2011 Northern Hills Software LLC. All rights reserved.
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